
 
 

 
 

BAB II 

LANDASAN TEORI 

 

 

2.1 Rancang Bangun 

Jogiyanto (2008), Rancang Bangun adalah tahap dari setelah analisis dari siklus 

pengembangan sistem yang merupakan pendefinisian dari kebutuhan kebutuhan 

fungsional, serta menggambarkan bagaimana suatu sistem dibentuk yang dapat 

berupa penggambaran, perencanaan dan pembuatan sketsa atau pengaturan dari 

beberapa elemen yang terpisah ke dalam satu kesatuan yang utuh dan berfungsi, 

termasuk menyangkut mengkonfigurasikan dari komponen-komponen perangkat 

keras dan perangkat lunak dari suatu sistem. 

 

Made Sumitre dan Rio Kurniawa (2014), Rancang bangun merupakan proses 

penting untuk mengetahui mengapa sistem informasi harus dibuat dan 

menentukan bagaimana cara membangun sistem tersebut, Langkah pertama dari 

proses tersebut adalah dengan mengidentifikasi peluang. 

 

Indera (2012), Rancang adalah  Tahap rancangan dilakukan untuk menetapkan 

bagaimana sistem  akan dioperasikan. Hal ini berkaitan dengan menentukan 

perangkat keras, perangkat lunak, jaringan, tampilan program, form dan laporan 

yang akan dipakai. 

 

2.2 Aplikasi 

Jogiyanto (2008), adalah program yang telah jadi dan siap digunakan atau 

program yang dibuat sendiri. Aplikasi berasal dari kata application yang artinya 

penerapan, lamaran, penggunaan. Secara istilah aplikasi adalah program siap 

pakai yang dibuat untuk melaksanakan suatu fungsi bagi penguna atau aplikasi 

yang lain dan dapat digunakan oleh sasaran yang dituju.  

 



6 

Amnah (2010), aplikasi digunakan untuk membantu kelancaran pelaksanaan 

pendidikan. Pertumbuhan ilmu komputer yang kian pesat, diiringi dengan 

Pertumbuhan pola pelayaan dan pengambilan keputusan yang cepat dan tepat. 

Untuk diperlukan hasil pengolaahn data yang disajikan secara akurat dan tepat 

waktu dengan didukung system yang baik. 

 

M. Miftakul Amin (2011) Aplikasi adalah suatu sistem untuk dapat mendungkung 

pelayanan dengan memanfaatkan teknologi nirkabel. 

 

2.3 Seni beladiri 

Gunun Arief (2007), Seni beladiri merupakan satu kesenian yang timbul 

sebagai satu cara seseorang itu mempertahankan diri. Seni beladiri telah lama 

wujud dan pada mulanya ia berkembang di medan pertempuran sebelum secara 

perlahan-lahan apabila peperangan telah berkurangan dan  penggunaan  senjata  

moden  mula  digunakan  secara  berleluasa, seni beladiri mula berkembang 

dikalangan mereka yang bukannya anggota tentera tetapi merupakan orang awam. 

 

2.4 Tapak Suci 

M. Barie Irsyad tahun 1991  Buku Panduan Seni Beladiri Tapak Suci : Pencak 

silat yang merupakan seni beladiri khas Indonesia memiliki ciri khas tersendiri 

yang dikembangkan untuk mewujudkan identitas. Demikian pula bahwa seni 

beladiri pencak silat di Indonesia juga beragam dan memiliki ciri khas masing-

masing. Tahun 1921 dalam konferensi Pemuda Muhammadiyah di Yogyakarta, 

KH. Busyro  bertemu  pertama  kali  dengan  dua  kakak beradik ;  A.Dimyati  

dan M.Wahib.  Diawali  dengan  adu  kaweruh  antara  M.Wahib  dengan  Achyat 

(kelak berganti nama menjadi H. Burhan), selanjutnya kedua kakak beradik ini 

mengangkat KH. Busyro sebagai Guru. KH.Busyro Syuhada kemudian pindah 

dan menetap di Yogyakarta sehingga aliran Pencak Silat Banjaran, yang pada 

awalnya dikembangkan melalui Pondok Pesantren Binorong kemudian 

dikembangkan di Kauman, Yogyakarta.Atas restu Pendekar Besar KH.Busyro, 

A. Dimyati dan M.Wahib diizinkan untuk membuka perguruan dan menerima 
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murid. Tahun 1925 dibukalah Perguruan Pencak Silat di Kauman, terkenal 

dengan mana Cikauman. Perguruan Cikauman, dipimpin langsung oleh Pendekar 

Besar M. Wahib dan Pendekar Besar A. Dimyati. Pendekar Moh. Barrie Irsyad, 

sebagai murid angkatan ke-6 yang telah dinyatakan lulus dalam menjalani 

penggemblengan oleh Pendekar M. Zahid, M. Syamsuddin, M. Wahib dan A. 

Dimyati. Kemudian mendirikan Perguruan KASEGU. Kasegu merupakan senjata 

khas yang berlafal Muhammad yang diciptakan oleh Pendekar Moh.Barrie 

Irsyad. Perguruan  Tapak  Suci  yang berkedudukan di Yogyakarta akhirnya 

berkembang di Yogyakarta dan daerah- daerah lainnya. Setelah meletusnya 

pemberontakan G30 S/PKI, pada tahun 1966 diselenggarakan Konferensi 

Nasional I Tapak Suci yang dihadiri oleh  para utusan Perguruan Tapak Suci 

yang tersebar di berbagai daerah di Indonesia. Pada saat itulah berhasil 

dirumuskan pemantapan organisasi secara   nasional, dan Perguruan Tapak Suci 

dikem-bangkan    lagi namanya menjadi Gerakan dan Lembaga Perguruan Seni 

Beladiri Indonesia Tapak Suci Putera Muhammadiyah. Dan  pada  Sidang 

Tanwir Muhammadiyah tahun 1967,  Tapak  Suci Putera Muhammadiyah  

ditetapkan   menjadi   organisasi   otonom di lingkungan Muhammadiyah, karena 

Tapak Suci Putera Muhammadiyah juga mampu dijadikan wadah pengkaderan 

Muhammadiyah.  

 

Susunan organisasi Tapak  Suci  dibuat  secara berjenjang dari tingkat Pimpinan 

Pusat, Pimpinan Wilayah, Pimpinan Daerah, dan Pimpinan Cabang. Pimpinan 

Pusat Tapak Suci adatah pimpinan tertinggi yang melaksanakan kepemimpinan 

dan bertanggung jawab keluar dan ke dalam. Pimpinan Wilayah Tapak Suci 

berkedudukan di ibu kota propinsi/daerah   tingkat I, bertindak sebagai Pimpinan 

Wilayah sekaligus Komisaris Pimpinan Pusat yang melaksanakan koordinasi 

administrasi dan operasional daerah. Pimpinan Daerah Tapak Suci berkedudukan 

disetiap kabupaten/kota administrasi sebagai pelaksana administrasi dan 

bertindak secara operasional. Untuk melancarkan tugas operasional, Pimpinan 

Daerah dapat mendirikan cabang Tapak Suci di daerahnya. Pimpinan Pusat juga 

dapat membentuk Perwakilan Wilayah di luar negeri sebagai pelaksana 
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administrasi dan bertindak secara operasional Keanggotaan Tapak Suci terdiri 

dari siswa, anggota penuh, dan anggota kehormatan. Yang dapat diterima 

menjadi Siswa Tapak Suci adalah anak-anak, remaja, dewasa putra-putri 

beragama Islam yang menyetujui Anggaran Dasar dan Anggaran Rumah Tangga 

Tapak Suci serta telah memenuhi persyaratan yang ditetapkan Anggota Penuh 

Tapak Suci terdiri dari Kader, pendekar dan pimpinan Tapak Suci yang telah  

memenuhi  persyaratan   keanggotaan yang diatur didalam Anggaran Rumah 

Tangga. Sedangkan anggota kehormatan Tapak Suci adalah orang yang karena 

jabatannya, kedudukannya dan atau keahliannya telah diangkat oleh  impinan 

Pusat Tapak Suci dengan surat ketetapan. 

 

 

 

    

 

 

Gambar 2.1 logo Tapak Suci 

 

Arti lambang tapak suci adalah Lambang berbentuk bulat yang berarti tekad bulat, 

berdasar biru berarti Keagungan, Bertepi hitam berarti Kekal dan abadi  

melambangkan  sifat Alloh Swt, Bunga Mawar berarti Keharuman, Warna  Merah  

berarti Keberanian, Daun Kelopak Hijau berarti Kesempurnaan, Bunga Melati 

Putih berarti Kesucian, Jumlah Sebelas berarti Rukun Islam dan Rukun Iman,  

Tangan Kanan Putih berarti Keutamaan, Terbuka berarti Kejujuran,  Berjari Rapat 

berarti Keeratan, Ibu Jari Tertekuk berarti Kerendahan Hati, Sinar Matahari 

Kuning berarti Putera Muhammadiyah. Keseluruhan lambang tersimpul dengan 

nama TAPAK SUCI yang mengandung arti Bertekad bulat mengagungkan asma 

Alloh Subhanahu wataala, kekal dan abadi. Dengan keberanian menyerbakan 

keharuman dengan sempurna, dengan kesucian menunaikan rukun islam dan 

rukun iman, mengutamakan keeratan dan kejujuran dengan rendah hati.  
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2.4.1 Jurus Dasar 

Jurus dasar Tapak Suci terbagi ke dalam delapan kelompok jurus yang 

masing-masing diberi nama dengan nama flora dan fauna. Masing-masing 

Jurus ini dibedakan sesuai dengan alat penyasar, karakter, dan kekhasan 

masing-masing. Karena setiap jurus dasar memiliki kegunaan yang berbeda-

beda maka dibuatlah bentuk-bentuk untuk membedakannya, seperti berikut : 

a. Alat penyasar adalah anggota tubuh yang digunakan untuk 

menyerang atau menangkis. 

b. Lintasan adalah garis yang dilalui oleh alat penyasar, bisa lurus, 

lingkar, atau gabungan lurus-lingkar. 

c. Arah  adalah letak titik sasaran terhadap titik awal lintasan. 

d. Pelaksanaan adalah cara melontarkan alat penyasar. 

e. Teknik kegunaan atau fungsi gerak yang tepat menuju sasaran. 

 

Adapun delapan (8) jurus dasar Tapak Suci sebagai berikut: 

1. Bunga Mawar  

Adalah gerakan yang mengguanakan punggung tangan atau ruas 

tekukan telapak tangan. Jurus bunga mawar terbagi menjadi dua 

yaitu sebagai berikut : 

a. Bunga Mawar Mekar 

- Alat penyasar adalah punggung telapak tangan dengan bentuk 

tangan tiga jari melengkung, telunjuk lurus, ibu jari 

melengkung renggang.  

- Sasaranmya adalah menepis serangan lawan. 

- Lintasan lurus dalam keluar bawah.  

- Teknik kegunaan atau fungsi adalah tangkisan. 

b. Bunga Mawar Layu 

- Alat penyasar adalah telapak tangan dalam dengan bentuk 

tangan tiga jari melengkung, telunjuk lurus, ibu jari 

melengkung renggang.  

- Sasaranmya adalah menepis serangan lawan. 
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- Lintasan lurus dalam ke dalam bawah.  

- Teknik kegunaan atau fungsi  adalah tangkisan. 

2. Harimau 

Adalah gerakan kaki dengan bentuk melingkar atau lurus kedepan. 

a. Harimau Membuka Jalan 

- Alat penyasar adalah telapak kaki bagian dalam, kelima jari 

menekuk ke atas.  

- Sasarannya yaitu ulu hati. 

- Lintasan lurus kedepan.  

- Teknik kegunaan adalah serangan (tendangan). 

b. Harimau Menutup Jalan 

- Alat penyasar adalah telapak kaki,  

- sasarannya  yaitu ulu hati.  

- Lintasan melingkar ke belakang, lurus ke depan dan ke atas. 

- Fungsi adalah serangan. 

3. Naga Terbang  

Adalah gerakan yang menggunakan telapak tangan bagian luar sisi 

ditekuk. 

- Alat penyasar adalah sisi telapak tangan luar bagian dalam, 

empat jari terbuka rapat, ibu jari ditekuk.  

- Sasarannya adalah leher atau ulu hati 

- Lintasan melingkar dari dalam ke depan.  

- Fungsi adalah serangan 

4. Rajawali  

Adalah gerakan yang digunakan untuk menangkis serangan 

dibawah tiga jari, diatas  ruas tangan . 

- Alat penyasar adalah sisi telapak tangan luar bagian dalam, 

empat jari terbuka rapat, ibu jari ditekuk.  

- Sasarannya adalah menangkis serangan dari lawan. 

- Lintasan keluar datar.  

- Teknik kegunaan atau fungsi adalah serangan (pukulan). 
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5. Merpati 

Adalah gerakan yang menggunakan ruas kedua jari tangan. 

- Alat penyasar adalah ruas jari tangan tengah, pada kelima jari 

tangan rapat melengkung ke dalam.  

- Sasarannya adalah dahi. 

- Lintasan lurus kedepan.  

- Teknik kegunaan atau fungsi adalah serangan (tendangan). 

6. Lembu  

Adalah gerakan yang menggunakan siku tangan dalam 

penggunaanya. 

- Alat penyasar adalah seluruh permukaan siku tangan.  

- Lintasan lurus kedepan.  

- Fungsi adalah serangan (sikutan) 

7. Katak  

Adalah gerakan yang menggunakan pukulan. 

- Alat penyasar adalah dua pangkal jari tengah dan telunjuk pada 

permukaan tangan mengepal.  

- Sasarannya ulu hati 

- Lintasan lurus ke depan.  

- Teknik kegunaan adalah serangan (pukulan). 

8. Ikan Terbang  

a. Ikan Terbang Menjulang ke Angkasa 

- Alat penyasar adalah pangkal jari telapak kaki, kelima jari 

membentuk sudut ke atas.  

- Sasarannya ulu hati. 

- Lintasan lurus ke depan.  

- Teknik kegunaan adalah serangan (tendangan). 

b. Ikan Terbang Menggoyang Sirip 

- Alat penyasar adalah punggung kaki pada kelima jari kaki 

rapat melengkung ke dalam.  

- Sasaranya badan bagian depan dan belakang 
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- Lintasan lingkar ke dalam datar.  

- Teknik kegunaan adalah serangan (tendangan). 

 

2.4.2 Teknik Praktis 

Teknik praktis adalah satu cara untuk mendapatkan rangkuman yang serasi 

dan benar dari tata gerak kaki dan lontaran jurus dasar, bertumpu pada 

kecepatan, ketepatan, dan kekuatan. Dalam setiap tingkat diberikan 

beberapa bentuk praktek dari materi yang telah dikuasai dalam bentuk 

teknik praktis berpasangan. Adapun teknik praktis yang digunakan sebagai 

berikut: 

1. Lawan bersiap melakukan tendangan menggunakan jurus Ikan 

Terbang Menjulang ke Angkasa. 

2. Memutar badan ke kanan sambil menangkap kaki lawan 

menggunakan jurus Bunga Mawar Menyongsong Matahari. 

Tangan kiri menekan leher lawan ke sebelah kiri luar, sementara 

tangan kanan masih memegang kaki lawan. 

3. Memutar badan ke arah kiri menggunakan jurus Terkaman 

Harimau. 

4. Lawan pun akan terjatuh dan terkunci. 

 

2.5 Android 

Nazaruddin (2012), Android merupakan sistem operasi untuk telepon seluler yang 

berbasis Linux. Android menyediakan platform terbuka bagi para pengembang 

untuk menciptakan aplikasi mereka sendiri untuk digunakan oleh bermacam 

piranti bergerak. Android umum digunakan di smartphone dan juga tablet PC. 

Fungsinya sama seperti sistem operasi Symbian di Nokia, iOS di Apple, dan 

BlackBerry OS. 

Terdapat beberapa versi android seperti dibawah ini menurut ialah : 

1. Android versi 1.1  

Pada 9 Maret 2009, Google merilis Android versi 1.1. Android versi ini 

dilengkapi dengan pembaruan estetis pada aplikasi, jam alarm, voice 
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search  (pencarian suara), pengiriman pesan dengan Gmail, dan 

pemberitahuan email.  

2. Android versi1.5 

Pada pertengahan Mei 2009, Google kembali merilis telepon seluler 

dengan menggunakan Android dan SDK (Software Development Kit) 

dengan versi 1.5 (Cupcake). Terdapat beberapa pembaruan termasuk juga 

penambahan beberapa fitur dalam seluler versi ini yakni kemampuan 

merekam dan menonton video dengan modus kamera, mengunggah video 

ke Youtube dan gambar ke Picasa langsung dari telepon, dukungan 

Bluetooth A2DP, kemampuan terhubung secara otomatis ke headset 

Bluetooth, animasi layar, dan keyboard pada layar yang dapat disesuaikan 

dengan sistem.  

3. Android versi 1.6  

Donut (versi 1.6) dirilis pada September dengan menampilkan proses 

pencarian yang lebih baik dibanding sebelumnya, penggunaan baterai 

indikator dan kontrol applet VPN. Fitur lainnya adalah galeri yang 

memungkinkan pengguna untuk memilih foto yang akan dihapus pada 

kamera, camcorder dan galeri yang dintegrasikan pada CDMA. 

4. Android versi 2.0/2.1  

Pada 3 Desember 2009 kembali diluncurkan ponsel Android dengan versi 

2.0/2.1 (Eclair), perubahan yang dilakukan adalah pengoptimalan 

hardware, peningkatan Google Maps 3.1.2, perubahan UI dengan browser 

baru dan dukungan HTML5, daftar kontak yang baru, dukungan flash 

untuk kamera 3,2 MP, digital Zoom, dan Bluetooth 2.1 

5. Android versi 2.2  

Pada 20 Mei 2010, Android versi 2.2 (Froyo) diluncurkan. Perubahan-

perubahan umumnya terhadap versi-versi sebelumnya antara lain 

dukungan Adobe Flash 10.1, kecepatan kinerja dan aplikasi 2 sampai 5 

kali lebih cepat, intergrasi V8 JavaScript engine yang dipakai Google 

Chrome yang mempercepat kemampuan rendering pada browser, 
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pemasangan aplikasi dalam SD Card, kemampuan WiFi Hotspot 

portabel,dan kemampuan auto update dalam aplikasi Android Market. 

6. Android versi 2.3   

Pada 6 Desember 2010, Android versi 2.3 (Gingerbread) diluncurkan. 

Perubahan-perubahan umum yang didapat dari Android versi ini, antara 

lain peningkatan kemampuan permainan, peningkatan fungsi copy paste 

,layar antar muka didesain ulang, dukungan format video VP8 dan WebM, 

dan dukungan jumlah kamera yang lebih dari satu.  

7. Android versi 3.0   

Android Honeycomb dirancang khusus untuk tablet. Android versi ini 

mendukung ukuran layar yang lebih besar. User Interface pada 

Honeycomb juga berbeda karena sudah didesain untuk tablet . Honeycomb 

juga mendukung multi prosesor dan juga akselerasi perangkat keras 

(hardware) untuk grafis.  

8. Android versi 4.0 

Diumumkan pada tanggal 19 Oktober 2011, membawa fitur Honeycomb 

untuk smartphone dan menambahkan fitur baru termasuk membuka kunci 

dengan pengenalan wajah, jaringan data pemantauan penggunaan dan 

kontrol, terpadu kontak jaringan sosial, perangkat tambahan fotografi, 

mencari email secara offline, dan berbagi informasi dengan menggunakan 

NFC.  

9. Android versi 4.1 ( Jelly Bean )  

Diumumkan pada tanggal 27 Juni 2012, android versi Jelly Bean 

merupakan peningkatan dari versi sebelumnya, dimana pada versi ini 

fungsi dan kinerja antarmuka pengguna sudah ditingkatkan menjadi lebih 

baik lagi seperti antisipasi sentuh, triple buffering, perpanjangan waktu 

sync, dan peningkatan frame rate hingga 60fps untuk menciptakan 

tampilan yang lebih halus.  

10. Android versi 4.4 ( KitKat )  

Diumumkan pada tanggal 3 September 2013 android dengan versi KitKat 

memiliki beberapa pembaruan antara lain Pembaruan antarmuka dengan 
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bar status dan navigasi transparan pada layar depan, Optimasi kinerja pada 

perangkat dengan spesifikasi yang lebih rendah, Kerangka kerja 

pencetakan, NFC Host Card Emulation sebagai emulator kartu pintar, 

WebViews berbasis Chromium, Perluasan fungsionalitas bagi layanan 

pendengar notifikasi, API umum untuk mengembangkan dan mengelola 

klien pesan teks, kemampuan untuk menentukan aplikasi SMS standar, 

Kerangka kerja baru untuk transisi UI, Kerangka kerja akses penyimpanan 

untuk mengambil konten dan dokumen dari sumber lain yang saling 

terintegrasi. 

 

2.5.1 Kelebihan Android 

Nazaruddin (2012) , dalam bukunya Hello Android, Operating System 

Android memiliki keunggulan antara lain : 

a. Sangat terbuka, development platform berbasis Linux dan Open source 

membuat para pembuat handset dapat mengeditnya tanpa membayar 

royalty. Developers menyukainnya karena mereka tahu bahwa platform 

ini “memiliki kaki” dan tidak terikat dengan vendor manapun yang 

dapat berada jauh dibawah ataupun diakuisisi. 

b. Arsitektur berbasis component yang terinspirasi dari kebebasan dunia 

internet. Bagian dari sebuah aplikasi dapat digunakan kembali dengan 

cara  yang tidak sama seperti apa yang dikembangkan developer. Ini 

akan membuat kreativitas baru di dalam dunia mobile. 

c. Grafis berkualitas tinggi dan suara halus, grafis vektor antialiased 2D 

dan animasi terinspirasi oleh Flash yang menyatu dengan 

3Deaccelerated OpenGL grafis untuk memungkinkan jenis baru 

permainan dan aplikasi bisnis. Codec untuk standar industri yang paling 

umum, audio, dan video format yang dibangun di tepat dalamnya, 

termasuk H.264 (AVC), MP3, dan AAC. 

d. Memiliki portabilitas di berbagai perangkat keras saat ini dan masa 

depan. Semua program ditulis di Java dan dieksekusi oleh mesin virtual 

Android  (Dalvik Android), sehingga kode Anda akan portabel di ARM, 
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arsitektur x86, dan lainnya. Dukungan untuk berbagai masukan 

termasuk metode seperti keyboard, sentuhan, dan trackball. Antarmuka 

pengguna dapat disesuaikan untuk setiap resolusi layar dan orientasi. 

 

2.6 Adobe Flash Profesional CS6 

Madcoms (2012), Adobe Flash Profesional CS6 adalah salah satu perangkat lunak 

komputer yang merupakan produk unggulan Adobe System. Adobe Flash 

Profesional CS6 merupakan software yang digunakan untuk menciptakan animasi 

dan konten multimedia. Desain pengalaman perancangan progaram interaktif yang 

hadir secara konsisten di seluruh desktop dan beberapa perangkat, termasuk tablet, 

smartphone, dan televisi. Dengan Adobe Flash Profesional CS6 kita dapat dengan 

mudah menggabungkan beberapa simbol dan urutan animasi menjadi lembaran 

sprite tunggal dan dioptimalkan untuk alur kerja yang lebih baik, dibuat lebih 

menarik dengan konten menggunakan ekstensi asli untuk mengakses kemampuan 

perangkat secara spesifik. 

Adapun area kerja pada Adobe Flash Profesional CS6 sebagai berikut : 

 

 

Gambar  2.2 Tampilan area kerja Adobe Flash CS6 

 

 

 

a 
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a. Toolbox 

Di dalam toolbox terdapat macam-macam tool yang bisa kita gunakan 

untuk menggambar objek. Toolbox ini terdiri dari beberapa bagian yaitu 

selection tool, drawing tool, painting tool, dan navigation tool. 

b. Timeline 

Timeline pada Adobe Flash CS6 secara default terletak diatas stage. 

Timeline  berfungsi untuk mengontrol keseluruhan objek dan animasi yang  

terdapat pada stage. 

c. Layer 

Layer dapat diilustrasikan seperti tumpukan-tumpukan yang berisi objek di 

dalamnya. Dengan layer, kita bisa mengatur movie pada stage dan 

menentukan kedalaman atau lapisan suatu objek. Untuk menambahkan 

layer baru, kita dapat memilih menu Insert > Timenline > Layer atau 

dengan mengklik icon yang terdapat pada bagian bawah timeline. 

Terdapat beberapa mode yang dapat dipilih pada layer di ataranya : 

 Guide layer, berfungsi untuk membuat animasi dengan menggunakan 

jalur atau track berupa garis yang telah dibuat. 

 Motion layer, digunakan untuk membuat pergerakan animasi tween. 

 Masking layer, digunakan untuk membuat animasi efek masking. 

d. Frame 

Frame merupakan bagian dari layer yang digunakan untuk mengatur 

pergerakan animasi. Di dalam frame bisa terdiri dari teks, gambar, 

audio,video, dan kode program ActionScript. 

Frame terdiri dari beberapa bentuk, di antaranya : 

 Keyframe, frame yang memiliki bentuk bulatan hitam, menandakan 

bahwa di dalamnya terdapat objek. 

 Blank keyframe, frame berbentuk bulat putih, menandakan bahwa frame 

masih kosong. 

 Action frame, frame dengan bulatan putih dan terdapat huruf ‘a’, 

menandakan di dalamnya terdapat kode program ActionScript. 
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 Frame label,  yaitu frame yang diberi nama label dan ditandai dengan 

bendera warna merah. 

e. Stage 

Stage adalah area putih berbentuk kotak yang terletak ditengah area  kerja 

Flash. Seperti istilah stage pada panggung teater, stage di dalam Flash 

berfungsi untuk menampilkan semua objek maupun movie yang berjalan 

diatasnya. Objek yang diletakan pada stage bisa berupa teks, gambar, dan 

video. 

f. Panel Properties 

Panel ini menampung semua properti yang terdapat pada tool-tool dalam 

Flash. Untuk mengaktifkannya, pilih menu Windows > Properties. 

g. Panel Library 

Seperti layaknya perpustakaan, library pada Flash berfungsi menampung 

semua simbol yang telah dibuat maupun hasil impor dari file luar seperti 

audio, video, gambar, dll.  Untuk menampilkan panel library,  bisa melalui  

menu Window > Library atau dengan menekan tombol CTRL+L. 

h. Panel Action 

Panel ini berfungsi sebagai tempat menuliskan ActionScript. Untuk 

mengaktifkannya, pilih menu Window > Action atau menekan tombol F9. 

 

2.7 Action Script 3.0 

Madcoms (2012), Action Script 3.0 adalah  bahasa pemrograman berorientasi 

objek untuk aplikasi dan script konten multimedia untuk membuat animasi 

atraktif. Action Script memiliki sintak yang mirip denga pemrograman java dan 

C#. 

 

2.8 Adobe Photoshop CS 

Khaeruddin (2008), Adobe Photoshop adalah program yang diorientasi untuk 

mengedit, memodifikasi, maupun memanipulasi bitmap atau foto. Perangkat 

lunak editor citra buatan Adobe System yang dikhususkan untuk pengeditan 

foto/gambar dan pembuatan efek. Perangkat lunak ini banyak digunakan oleh 
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fotografer digital dan perusahaan iklan sehingga dianggap sebagai pemimpin 

pasar untuk perangkat lunak pengolah gambar/foto, dan bersama Adobe Acrobat, 

dianggap sebagai produk terbaik yang pernah diproduksi oleh Adobe Systems, 

Versi kedelapan aplikasi ini disebut dengan nama Photoshop CS (Creative Suite), 

dan versi yang terakhir (ketigabelas) adalah Adobe Photoshop CS6. 

 

2.9  Adobe Premiere Pro 

Wahana Komputer (2005), Adobe Premiere Pro dibuat oleh Adobe System Inc, 

yang merupakan versi pembaharuan dari beberapa versi Adobe Premiere 

terdahulu. Adobe Premiere Pro mulai di luncurkan ke pasaran pada bulan Agustus 

tahun 2003. Mulai versi 6.0 Adobe Premiere dapat digunakan untuk mengedit file 

video dengan format DV. Adobe Premiere telah menjadi program standar bagi 

para profesional dalam bidang digital video. 

 

2.10 Adobe AIR 

Wahana Komputer (2014), Adobe AIR adalah sebuah cross operation system 

runtime yang di kembangkan oleh Adobe sehingga memungkinkan pengembang 

memanfaatkan keterampilan seperti (Flash, Flex, HTML, JavaScript, dan PDF) 

untuk membuat RIA (Rich Internet Application) dan kontennya ke dalam platform 

baru. 

  

2.11 Unifed Modeling Languange (UML) 

Rosa A. S. Dan M. Shalahuddin (2016). Unified Metodologi Language (UML) 

adalah Salah satu standar bahasa yang digunakan di dunia industri untuk 

mendefinisikan requirement, membuat analisis dan desain, serta menggambarkan 

arsitektur dalam pemograman berorientasi objek. 

 

2.11.1 Use Case Diagram 

Rosa A. S. Dan M. Shalahuddin (2016) mendefinisikan Use Case Diagram 

sebagai gambaran bagaimana seorang user berinteraksi dengan sistem dan 
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mendefinisikan langkah-langkah yang diperlukan untuk mendapatkan hasil 

yang spesifik. 

Ada dua element utama pada use case Diagram yaitu pendefinisian actor 

dan use case 

a. Actor yaitu sebagai figur utama yang direpresentasikan sebagai seorang 

aktor yang dasosiasikan dengan satu kategori dari user atau elemen 

interkasi yang lain.  

b. Use Case digambarkan dengan bentuk oval. Dan digunakan untuk 

bertukar pesan yang disediakan oleh sistem. 

 

Gambar 2.3 Elemen Utama Pada Use Case Diagram 

 

2.11.2 Sequence Diagram  

Rosa A.S dan M. Shalahuddin (2016), Sequence Diagram  menggambarkan 

kelakuan objek pada use case dengan mendeskripsikan waktu hidup objek 

dan message yang dikirimkan dan diterima antar objek. 

Dalam membuat Sequence Diagram harus memiliki acuan untuk melihat 

scenario yang ada pada use case. Banyaknya diagram sequen yang harus 

digambar adalah minimal sebanyak pendefinisian use case yang dimiliki 

pada setiap proses. Sehingga semakin banyak use case yang didefinisikan 

maka Sequence Diagram yang harus dibuat juga semakin banyak. 

Simbol-simbol Sequence Diagram dapat dilihat pada Tabel 2.2 berikut :  
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Tabel 2.1 Simbol Sequence Diagram 

Simbol Deskripsi 

Garis hidup/lifeline 

 

 

Menyatakan kehidupan suatu objek. 

Objek  

 

 

Menyatakan objek yang berinteraksi 

pesan. 

Waktu aktif  

 

 

 

Menyatakan objek dalam keadaan aktif 

dan berinteraksi, semua yang terhubung 

dengan waktu aktif ini adalah sebuah 

tahapan yang  dilakukan di dalamnya. 

Pesan tipe create 

<<create>> 

 

Menyatakan suatu objek membuat objek 

yang lain, arah panah mengarah pada 

objek yang dibuat. 

Pesan tipe call 

1 :  nama_metode() 

Menyatakan suatu objek memanggil 

operasi/metode yang ada pada objek 

lain atau dirinya sendiri. 

Pesan tipe send 

 

1 : masukan 

Merupakan bahwa suatu objek 

mengirimkan data/masukan/informasi 

ke objek lainnya, arah panah mengarah 

pada objek yang dikirim. 

Pesan tipe return 

 

1 : keluaran 

Menyatakan bahwa suatu objek yang 

telah menjalankan suatu operasi atau 

metode menghasilkan suatu kembalian 

ke objek tertentu, arah panah mengarah 

pada objek yang menerima kembalian. 

 

 

 

 

 

nama objek : nama kelas 
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Tabel 2.1 Simbol Sequence Diagram (lanjutan) 

Simbol Deskripsi 

Pesan tipe destroy 

<<destroy>> 

 

 

 

Menyatakan suatu objek mengakhiri 

hidup objek yang lain, arah panah 

mengarah pada objek yang diakhirim 

sebaliknya jika ada create maka ada 

destroy. 

Aktor  

 

 

atau 

Orang, proses, atau sistem lain yang 

berinteraksi dengan sistem informasi 

yang akan dibuat di luar sistem 

informasi yang akan dibuat itu sendiri, 

jadi walaupun simbol dari aktor adalah 

gambar orang, tapi aktor belum tentu 

merupakan orang; biasanya dinyatakan 

menggunakan kata benda di awal frase 

nama aktor. 

 

2.11.3 Activity Diagram 

Rosa A.S dan M. Shalahuddin (2016), diagram aktivitas atau activity 

diagram menggambarkan workflow (alir kerja) atau aktivitas dari sebuah 

sistem atau proses bisnis atau menu yang ada pada perangkat lunak. Yang 

perlu diperhatikan disini adalah bahwa diagram aktivitas menggambarkan 

aktivitas sistem bukan apa yang dilakukan aktor, jadi aktivitas yang dapat 

dilakukan oleh sistem. 

Simbol-simbol yang ada pada diagram aktivitas dapat dilihat pada Tabel 2.3 

berikut ini : 

 

 

 

 

 

nama_aktor 
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Tabel 2.2 Simbol Activity Diagram 

Simbol Deskripsi 

Status awal 

 

Status awal aktivitas sistem, sebuah 

diagram aktivitas memiliki sebuah 

sistem awal. 

Aktivitas 

 

 

Aktivitas yang dilakukan sistem, 

aktivitas biasanya diawali dengan 

kata kerja. 

Percabangan/decision 

 

 

Asosiasi percabangan dimana jika 

ada pilihan aktivitas lebih dari satu. 

Penggabungan/join 

 

 

Asosiasi penggabungan dimana 

lebih dari satu aktivitas 

digabungkan menjadi satu. 

Status akhir Status akhir yang dilakukan sistem, 

sebuah diagram aktivitas memiliki 

sebuah status akhir. 

Swimlame 

 

 

 

Memisahkan organisasi bisnis yang 

bertanggungjawab terhadap 

aktivitas yang terjadi. 

 

2.12 Prototype (Prototyping Model) 

Rosa A.S. dan M. Shalahuddin (2016), model prototype (prototyping model) 

dimulai dari mengumpulkan kebutuhan pelanggan terhadap perangkat lunak yang 

akan dibuat. Lalu dibuatlah program prototype agar pelanggan lebih terbayang 

dengan apa yang sebenarnya  diinginkan. Program prototype biasanya merupakan 

program yang belum jadi. Program ini biasanya menyediakan tampilan dengan 

simulasi alur perangkat lunak  sehingga tampak seperti perangkat lunak yang 

sudah jadi. Program prototype ini dievalusai oleh pelanggan atau user sampai 

aktivitas 

nama swimline 
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ditemukan spesifikasi yang sesuai dengan keinginan pelanggan atau user. Berikut  

ini adalah gambar dari model prototype : 

 

 Gambar 2.4 Ilustrasi Model Prototipe 

  

Mock-up adalah sesuatu yang digunakan sebagai model desain yang 

digunakan untuk mengajar, demonstrasi, evaluasi desain, promosi, atau 

keperluan lain. Sebuah mock-up disebut sebagai prototype perangkat lunak 

jika menyediakan atau mampu mendemonstrasikan sebagian besar fungsi 

sistem perangkat lunak dan memungkinkan pengujian desain sistem 

perangkat lunak. 

 

Proses pada model prototyping dapat dijelaskan sebagai berikut : 

a. Mendengarkan Pelanggan  : Developer dan klien bertemu dan menentukan 

tujuan umum, kebutuhan yang diketahui dan gambaran bagian-bagian 

yang akan dibutuhkan berikutnya oleh pelanggan. 

b. Membangun dan memperbaiki Mock-up : Perancangan dilakukan cepat 

dan rancangan mewakili semua aspek perangkat lunak yang diketahui, dan 

rancangn ini menjadi dasar pembuatan prototype. 

c. Melihat dan Menguji Evaluasi prototype : Klien mengevaluasi prototype 

yang dibuat dan digunakan untuk memperjelas kebutuhan perangkat lunak. 

Perulangan ketiga proses ini terus berlangsung hingga semua kebutuhan 

terpenuhi. Prototype-prototype dibuat untuk memuaskan kebutuhan klien 

dan untuk membangun perangkat lunak lebih cepat, namun tidak semua 

Mendengark

an Pelanggan 

Membangun/ 

Memperbaiki 

Mock-up 

Pelanggan 

Melihat dan 

Menguji 

Mock-up 
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prototype bisa dimanfaatkan. Demi kebutuhan klien lebih baik prototype 

yang dibuat diusahakan dapat dimanfaatkan. 

 

2.13 Data Pengguna Smartphone 

Berdasarkan data riset dari Indonesian Digital Association (IDA), yang didukung 

oleh Baidu Indonesia, dan dilaksanakan oleh lembaga riset global GfK. Pengguna 

smartphone yang ada di Indonesia yaitu  96 persen yang merupakan angka 

tertinggi dibandingkan media lain seperti televisi, surat kabar serta. Riset yang 

dilakukan di 5 kota besar di Indonesia selama penghujung pada 2015, mencakup 

1.521 panelis dan 775 responden yang dilakukan interview langsung.  

Menurut data Kementerian PPPA bersama UNICEF menganalisis aktivitas dan 

perilaku online dikalangan anak dan remaja setidaknya 30 juta anak-anak dan 

remaja usia 10-19 tahun di Indonesia merupakan pengguna internet, dan media 

digital saat ini menjadi pilihan utama saluran komunikasi yang mereka gunakan.  

Pengguna smartphone di Indonesia sangatlah banyak, begitu juga dengan anak-

anak dan remaja usia 10-19 tahun yang menggunakan smartphone untuk 

mengakses internet. Dengan penggunaan yang banyak membuat anak-anak dan 

remaja lebih banyak mengahabiskan waktunya untuk bermain dan belajar dan 

menggunakan smartphone untuk mengakses aplikasi dan situs – situs yang 

menunjang kegiatan belajar mereka. Sehingga untuk saat ini banyak aplikasi 

media pembelajaran yang dibuat untuk membantu kegiatan belajar yang 

digunakan di smartphone. 
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2.14 Penelitian Terdahulu 

Pada bagian ini membahas tentang penelitian yang terdaluhu untuk menjadi acuan 

dalam pembuatan karya ilmiah, dapat dilihat pada tabel 2.3 sebagai berikut : 

 

Tabel 2.3 Penelitian Terdahulu 

No Nama Judul 
Tahun 

Terbit 
Keterangan 

1 Cornelius 

Galih Jati 

Kusuma 

 

Rancang 

Bangun 

Aplikasi 

Olahraga 

Bola Voli 

Berbasis 

Android 

 

2016 Aplikasi olahraga bola voli ini 

dirancang dengan menggunakan 

metode prototype yang memiliki 

beberapa tahapan yaitu mendengarkan 

pelanggan, membangun dan 

memperbaiki prototype serta 

pelanggan menguji coba prototype. 

Pembuatan aplikasi ini menggunakan 

bahasa pemrograman ActionScript 3.0 

dan dibangun menggunakan Adobe 

Flash Profesional CS6. Perancangan 

aplikasi ini untuk membantu para 

pemain memperoleh informasi tentang 

peraturan dan teknik dalam bola voli. 

Penelitian ini menghasilkan sebuah 

aplikasi olahraga bola voli yang 

berbasis android. Penggunaan aplikasi 

ini dapat membantu para pemain 

dalam mempelajari, memahami dan 

menerapkan peraturan dan teknik 

dalam bola voli dengan baik.  

2 Randika 

Agung 

Aplikasi 

Bantu 

2016 Seorang Taekwondoin harus melewati 

tahapan-tahapan yang panjang dan 
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Pratama 

 

Belajar 

Teknik 

Beladiri 

Taekwond

o 

Berbasis 

Android 

tidak mudah, yaitu seorang 

Taekwondoin harus menyandang 

minimal sabuk biru Taekwondo dan 

sudah menguasai semua teknik dasar 

Taekwondo minimal sampai ke tingkat 

sabuk biru. Mempunyai kemampuan 

untuk melatih, menjadi asisten pelatih 

sampai tingkat sabuknya mencapai 

sabuk merah dan kemampuan 

melatihnya sudah siap diberikan 

kepada atletnya kelak. Untuk 

membantu pelatih Taekwondo pemula 

meningkatkan kemampuan nya untuk 

diajarkan kepada atletnya kelak maka 

dibangunlah sebuah aplikasi bantu 

belajar teknik beladiri Taekwondo ini. 

Dalam membangun sebuah aplikasi 

bantu belajar ini, metode 

pengembangan yang digunakan yaitu  

metode prototype yang memiliki 

beberapa tahapan yaitu, pengumpulan 

kebutuhan, perancangan, dan evaluasi 

prototype. 

Penelitian ini menghasilkan sebuah 

aplikasi bantu belajar teknik beladiri 

Taekwondo berbasis android yang 

dapat digunakan untuk meningkatkan 

kemampuan pelatih Taekwondo 

pemula dalam melatih atletnya.  

 

 


